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Introduction 
Overtime Hours Rules product allows users to better manage overtime scenarios and configure multiple 

methods of calculating overtime hours to be paid to employees. 

The user can now accommodate rules that may vary based on employee, department, position or rules that are 

unique to certain states or companies. Overtime is managed based on day, week, pay period or all three 

combined. 

Process 
The main process for Overtime Hours Rules could be described as follows: 

 The user establishes and configures Overtime Rule Codes.  

 The rule codes describe how overtime is to be measured and how it is to be recorded in transactions. It 

also describes which pay codes are going to be subject to the rules.  

 Rule codes are then assigned to employees and can be configured by employee.  

 During payroll, the Overtime Hours process runs and searches for transactions with pay codes that 

should be considered for overtime. 

 The payroll transactions that match the setup parameters are split into normal and overtime 

transactions. 

 The process runs in different ways depending on how the user has configured the order in which 

calculation occurs via the Rule Priority.  

 Additionally the user can mass assign Overtime Hours Rules to employees. 

Quick Setup Steps 
The following are the quick reference steps necessary to set up the Overtime Hours Rules product and begin 

processing transactions immediately: 

1. The first step in using Overtime Hours Rules is to make sure that the Automatic Overtime function of 

Microsoft Dynamics GP is disabled in Payroll Setup window. Overtime Hours Rules replaces standard 

overtime functionality in Microsoft Dynamics GP. [Microsoft Dynamics GP > Tools > Setup > Payroll > 

Payroll] 

2. Activate Overtime Hours Rules in the Overtime Hours Rules Setup window and specify a Rule Priority. 

The default will be daily, weekly and period. 

3. Create Overtime Rules in Overtime Rules Setup window which most accurately reflect the businesses 

rules and regulations for handling overtime.  

4. Designate any default rules (optional). Default rules will apply to any employees who have no rules 

explicitly defined for them. Default rules are a quick way to start using Overtime Hours Rules but do 

not apply when employees have other rules assigned, see Default Rules section for more information. 

5. Assign any rules to employees if default rules do not apply to the employee. 
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6. Now that setup is complete, run payroll. 

Default Rules 
A default rule is a rule that applies to employees who do not have an overtime rule code assigned and meet 

the overtime criteria on the Overtime Rules Setup window.  

One default rule may be specified for each Rule Type.  There are three rule types: daily, weekly and period.  An 

employee may be subject to none, one or multiple default rules. 

As long as the employee has no overtime rules explicitly assigned to them in Employee Overtime Rules 

Maintenance window, then the default rule(s) will apply. 

As soon as a single overtime rule is specified for an employee 

the system will ignore all default rules for the employee and 

process only the rule that was assigned to the employee. If 

the rule assigned to the employee is of a different type than 

the default rule(s) the system will process only the rule 

assigned to the employee. 

The default rule will be applied to all the employees who 

currently do not have an overtime rule assigned to them. If an 

overtime rule has been created and assigned to an employee, 

the default rule is overridden. 

Default rules are generally not 

assigned to employees explicitly. 

They exist for the purpose of 

providing the system with a rule to 

use on all employees. There are 

however, circumstances where it 

may be useful to explicitly assign a 

default rule. (See Scenarios.) 
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Installation Overview  
This section will discuss the prerequisites, list the files installed and go through the install process.  

Prerequisite 
The prerequisite for Overtime Hours Rules is: 

 Microsoft Dynamics GP Payroll 

Install Notes  
Prior to installing complete the steps below: 

1. Confirm all users are logged out of Dynamics GP 2015 or 2016 

2. Complete all payroll runs and validate no payrolls are in process  

3. Make a backup of the Company and Dynamics databases  

If Integrity Data Products Comprehensive Leave Manager and Negative Payroll Transactions are registered, 

insure the following settings: 

 When using both Comprehensive Leave Manager and Overtime Hours Rules, the OHR6489.dic file 

must be referenced prior to the ELM.dic file in the users Dynamics.set file. 

 When using both Negative Payroll Transactions and Overtime Hours Rules, Negative Payroll 

Transactions must be entered into the system on the beginning date of the transactions. 

Server/Client 
To install Overtime Hours Rules downloaded the exe file from our website.  Once the files have been 

downloaded, you can run them on the Server and/or Client Installations.   The product will need to be installed 

on all machines that process payroll.  If you will send with using Microsoft Outlook then download the Outlook 

Setup.exe in addition to the Integrity GP 2015 or 2016 Setup.exe 

Complete the steps required at the Server and/or Client level to create the necessary Microsoft SQL Server® 

Components.  Creating the Microsoft SQL Server Components needs to be performed on a single computer, 

typically the server. 

1. Right click Integrity Data GP2015 or 2016 Setup.exe file and select “Run as Administrator”.  If you do 

not see this option, hold the shift key down and right click. 

2. Complete the steps in the wizard 

http://www.integrity-data.com/hrp/product-download-form/0310360942-2/
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3. Verify the GP directory is correct if it is not select Change 
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4. Select Custom to choose to install only the specific products you purchased.   

5. Select Activation Components to only install activation manager files.  This option will not install 

products and it is typically run only to fix an error with activation manager. 

6. Select All Components to install all Integrity Data products.  The products you did not purchase will 

register with a 30-day trial period.   
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If you are upgrading you will be prompted to uninstall the older version, select “y”. If you have multiple 

products, it will uninstall all products. 

 

7. Select the product(s) to install, if installing multiple products, select all that need to be installed. 
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8. Launch Microsoft Dynamics GP 2015 or 2016. 

9. If prompted to include new code, choose yes. 

10. Login as the ‘system administrator’ for each company to create the SQL Server components. 

11. The system will auto activate the products you have purchased if you have access to the internet on 

the machine.  If you receive a message Activation Manager failed contact support@integrity-data.com 

and include a screenshot of the Activation Manager window to receive manual keys. 

  

BEST PRACTICES 

Install is not a requirement 
on the Server; however it is 

recommended. 

Install updated version on 
previously installed Client 

machines. 
 

 

mailto:support@integrity-data.com
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Manual Install 

If the user encounters errors during the installation, complete the following steps to manually install Overtime 

Hours Rules: 

1. Contact support@integrity-data.com to receive the manual install files for the product(s). 

2. Copy and paste the files into the appropriate locations. 

 

GP Folder (C:\Program Files\Microsoft Dynamics\GP2015) or (C:\Program Files\Microsoft 

Dynamics\GP2016) 

 OHR6489.cnk or OHR6489.dic 

 IDA6537.cnk  

 Integrity.Registration.Addin.dll  

 Application.IntegrityDataActivation.dll  

 Integrity.Registration.Constructor.dll  

 

Documentation Folder (C:\Program Files\Microsoft Dynamics\GP2015\Documentation) or 

(C:\Program Files\Microsoft Dynamics\GP2016\Documentation) 

 Overtime Hours Rules User Guide.pdf  

 

3. Edit the Dynamics.exe.config 

 Navigate to the GP folder (C:\Program Files\Microsoft Dynamics\GP2015) or (C:\Program 

Files\Microsoft Dynamics\GP2016) 

 Backup the Dynamics.exe.config by making a copy and saving the copy **Important** 

 Open Dynamics.exe.config in Notepad 

 Find the <addin> and under <Dynamics> copy and paste the following: 

<addin name="IDKeyManagerAddIn" 

type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.202

97,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/> 

 Under <DynamicsGPweb> copy and paste the following: 

<addin name="IDKeyManagerAddIn" 

type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.202

97,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/> 

mailto:support@integrity-data.com
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4. Launch Microsoft Dynamics GP. 

5. Login as the ‘system administrator’ for each company to create the SQL Server components. 

Files Installed  

The following files are installed: 

GP Folder (C:\Program Files\Microsoft Dynamics\GP2015) or (C:\Program Files\Microsoft 

Dynamics\GP2016) 

 OHR6489.cnk or OHR6489.dic 

 IDA6537.cnk  

 Integrity.Registration.Addin.dll  

 Application.IntegrityDataActivation.dll  

 Integrity.Registration.Constructor.dll  

 

Documentation Folder (C:\Program Files\Microsoft Dynamics\GP2015\Documentation) or 

(C:\Program Files\Microsoft Dynamics\GP2016\Documentation) 

 Overtime Hours Rules User Guide.pdf  
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Registration 
The system will automatically activate the product during the login process.  If the activation was successfully, 

the user will not receive any message. However, if the activation process was unsuccessful the user will receive 

a message.  If the activation process fails the user will need to open the Activation Manager window to 

activate the product. 

Activation Manager Window 
Microsoft Dynamics GP > Tools > Setup > System > Activation Manager 

 

The Site Name defaults from the session information on the About Microsoft Dynamics GP window. 

From the Product drop-down list the user may select the product they wish to activate and review product 

information.  Once the product is selected the following fields will display: 

 Installed Version – Current version number installed. 

 Enhancement Plan Date – Date of the enhancement plan expiration. 

 Activation Status – Current status of the product. 

o Permanent – Product has been purchased. 

o Trial – Product has been issued a trial period. 

o Deactivated – Product has been deactivated. 

 Current Employees – This count defaults from the session information on the About Microsoft 

Dynamics GP window.  The count does not include inactive employees or employees in a Test or 

Historical company.  If the current employee count is incorrect validate Test or Historical companies 

are named correctly. 

 Employees Allowed – The number of employees allowed before the product will be inactivated.  If the 

Current Employees exceeds the Employees Allowed the system will deactivate the product. 
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The scrolling window contains a list of all companies. By default the product is active for all companies.  If the 

user would like to inactivate a company unmark the company checkbox. 

The Auto Activation option may be selected if the user receives a message at login stating the product is not 

activated.  When the user selects the Auto Activation option the system will attempt to automatically activate 

the product.  Once the Auto Activation process is complete the system will display the Activation Messages.  

For a detailed list of activation messages see the Activation Manager Messages section. 

The Manual Activation option is used to manually enter a token.  The user would only manually enter a token if 

they were sent a token by Integrity Data. 

Select the OK button to close the window. 

Test and/or Historical Companies 

Registration will not count the active employees in Test or Historical company databases if the Company 

Name is named correctly, specifically at the end of the Company Name the user must append the following: 

“<TEST>” or “<HISTORICAL>”. See examples below: 

 Dextordinary, Inc. <TEST> 

 Dextordinary, Inc. <HISTORICAL> 

To access and modify the Company Name open the Company Setup window via Microsoft Dynamics GP > 

Tools > Setup > Company > Company when logged into the Test or Historical Company that needs modified. 

Version Information 
To obtain the latest Overtime Hours Rules version information, visit our website. 

Within Microsoft Dynamics GP verify the version for Overtime Hours Rules by selecting the Help Button, select 

About Microsoft Dynamics GP and then select the Options button. Click OK until the Overtime Hours Rules 

window appears. 

http://www.integrity-data.com/hrp/product-releases/
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Security Settings  
The Security Task Setup window may be used to grant or restrict access to the Overtime Hours Rules windows. 

To open the window, select the Microsoft Dynamics GP menu, select Tools, select Setup, select System, select 

Security Tasks, and enter the system password. 

1. Select the appropriate Task items. To identify the appropriate task item complete the steps below: 

• Open the User Security Setup window (Microsoft Dynamics GP > Tools > Setup > User 
Security), select the appropriate user and make a note of the Security Role ID assigned to the 
user. 

• Open the Security Role Setup window (Microsoft Dynamics GP > Tools > Setup > Security 
Roles), select the Role ID that has been assigned to the user and make note of the Security 
Task ID assigned to the Role. Use this Task ID to grant security to the Overtime Hours Rules. 
NOTE: The most common Task ID used is TRX_PAYRL_004 – Print Payroll Checks 

2. Select Overtime Hours Rules for the Product. 

3. Select Windows for the Type and select 3rd Party for the Series. 

4. Use the Access List to grant or restrict access to individual items. 

 To grant or restrict access to an item for this Task ID, click the checkbox to mark or unmark 
the item. 

 Click the Mark All button to grant access to all items in the list or click the Unmark All button 
to restrict access to all items in the list. 

5. Click File > Print to print the Security Task Setup Report for the selected Task ID. 

6. Choose OK to save your changes. 

 

Overtime Hours Rules > Windows > 3rd Party > Access List 

 APR Main Menu 

 Employee Overtime Rules Maintenance 

 OHR fields 

 Overtime Hours Rules Setup 

 Overtime Rules 

 Overtime Rules Setup 

 Registration – OHR 

 Rule Code Mass Assign 
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Overtime Hours Rules Setup Window 
Microsoft Dynamics GP > Tools > Setup > Payroll > Overtime Hours Rules Setup 

The Overtime Hours Rules Setup window is used to activate the Overtime Hours Rules product and specify the 

Rule Priority Setup order for calculating overtime. 

  

The Activate Overtime Hours Rules checkbox is unmarked by 

default and must be marked before the system will activate the 

overtime rules process during calculation. The Activate Overtime 

Hours Rules checkbox must also be marked in order for Rule 

Priority Setup to be specified. If the user receives an error message 

“You must inactivate the Automatic Overtime feature in GP before 

activating Overtime Hours Rules.” or “You must inactivate Overtime Hours Rules before activating Automatic 

Overtime.” More detailed information and solution is provided in the Overtime Hours Rules Messages section. 

 

When the Prevent overtime adjustments to pay codes to type 

Vacation, Sick and Holiday is marked the system will include hours 

for pay codes of type Vacation, Sick and Holiday in the overtime 

hours calculation but will not adjust hours for those pay codes. 

Rule Priority Setup refers to the order in which the Overtime Hours 

Process will calculate overtime hours. Using the default example 

above the system would calculate any overtime as a result of hours 

worked during the day first. Then it would calculate weekly hours 

and apply any overtime rules that apply to the number of hours in 

the week. Lastly, it will process rules for the period as a whole. 

The system will not allow you to 

mark the checkbox and exit the 

window if you have not already 

disabled the Automatic Overtime 

function of Microsoft Dynamics 

GP in the Payroll Setup window. 

 

The order in which rules are 

applied will influence the 

overtime transactions. (See 

Overtime Hours Rules Process 

for Rule Priority example) 
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The Source for Overtime Transaction Rate contains a drop-down list that allows the user to select from three 

options on how to determine the rate used for overtime hours transactions. 

 Employee Pay Code – the rate for the overtime pay code transaction will be pulled from the Employee 

Pay Code Maintenance window for the overtime pay code. 

 Originating Transaction – the rate for the overtime pay code transaction will be pulled from the 

payroll transaction that created the overtime transaction. For example, if the original transaction was 

HOUR at a rate of $12 the system would apply the overtime rules and create any necessary overtime 

transactions. The overtime transactions would have a rate of $12.   

 Originating Transaction w/ Factor – the rate for the overtime pay code transaction will be pulled from 

the payroll transaction that created the overtime transaction and then the overtime factor will be 

applied. For example, if the original transaction was HOUR at a rate of $12 the system would apply 

the overtime rules and create any necessary overtime transactions. If the factor for the overtime pay 

codes was .5 the system would apply a rate of $6 for the overtime transaction.  
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Overtime Rules Setup Window 
Microsoft Dynamics GP > Tools > Setup > Payroll > Overtime Rules 

The Overtime Rules Setup window is used to create overtime rules that will be assigned to employees and will 

dictate the way overtime transactions are created in payroll. 

 

Rule Code - Create a rule code which may contain alphanumeric and a maximum of six characters long. 

Default – Mark this checkbox to set this rule as a default rule. Only one rule can be marked as the default 

rule for each Rule Type. Thus, it is possible to have up to three default rules marked, one for each rule type.  

Default rules do not have to be assigned to an employee to function. When an employee has no 

rule code assigned, any and all rules marked as default will apply to that employee. (See 

Scenarios) When an employee has at least one rule code assigned then no default rules apply and 

only the rule codes explicitly assigned to the employee will apply. 

Inactive – Mark this checkbox to inactivate a rule code. The employees may keep using the rule code if the 

user does not roll down the changes, as this would inactivate the code at the employee level. 

 

Include History TRX – Mark this checkbox to include history transactions from previous payrolls.  For 

example, if the pay period dates are 01/16/2001 to 01/31/2001 but the overtime rule should look at pay 

codes for the week starting on Sunday 01/14/2001.  The first transaction is for 01/16/2001 if the Include 
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History TRX is marked the system will look at the payroll history for 01/14/2001 and 01/15/2001 for the 

included codes to determine if the employee has exceeded the range for overtime. 

Leave Originating TRX – Mark this checkbox to not reduce the hours from the originating transaction used 

to create an overtime transaction.  If an employee worked 10 hours and anything over 8 hours is 

considered overtime, if the checkbox is unmarked the system will reduce the 10 hours to 8 and create an 

overtime transaction for 2 hours.  If the checkbox is marked the system will create the overtime 

transaction for 2 hours and leave the originating transaction at 10 hours.   

Remove After Blended Rate Calc – Mark this checkbox if using Overtime Rate Manager to blend the 

overtime rates.  The system will calculate the blended rates and create the overtime transaction.  After 

the calculation it will reduce the originating transaction and add the rate from the originating transaction 

to the overtime code.   

For example, the rule states any time over 40 hours a week results in overtime.  If an employee 

worked 10 hours the first four days in pay code HOUR at a rate of $20.00 then worked 10 hours on 

day five  in pay code HOUR 2 with a rate of $10.00 the system would allow Overtime Rate Manager 

to calculate the rate at $9.00 ($900.0/50 hours =$ 18.00 per hour * .5 = $9.00).  After the blended 

rate is calculated the system reduces day 5 transaction to 0 hours and adds the $10.00 rate to the 

overtime code.  The final result is 40 hours at $20.00 and 10 overtime hours at $19.00. 

7th Consecutive Day Overtime – Mark this checkbox if using Overtime Hours Rules  to calculate all time on 

a 7th day as overtime. This is enabled only for weekly rule types. When checked, if an employee works all 7 

days of a given “pay week” the system will process all time on day 7 as overtime.  An important distinction 

is that it is not any consecutive 7 day period; it is the 7 day period as defined by the pay week.  Thus, one 

could work the last 4 days of week 1 and the first 3 days of week 2, and the system will NOT process day3 

of week 2 as overtime based on this setting.  

 

Rule Description – The Rule Description is for clarification purposes of the rule and does not impact the 

calculation. 

Rule Type 

There are three rule types to choose from: Daily, Weekly and Period.  

 Daily rules will apply rules to daily transactions. 

For example, if the company policy states anything over 8 hours 

a day is considered overtime.  If there are multiple transactions 

for a single day, the system will add all the transactions 

together and see if they exceed 8 hours total when using the 

daily rule. 

 Weekly rules will apply rules to transactions that happen within 

a given week. 

o Begin Pay Week options will allow the user to define a 

day of the week when a pay week begins or define that a pay week begins when the first 

transaction begins.  

Attention California 

Users! 

Use this option to comply 

with State Overtime 

regulations. 
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During the build process when a weekly rule is calculated, the calculation will start the 7 

day count for a weekly rule using the settings defined for Begin Pay Week. The system 

will look to the first transaction for the employee (called transaction X for this example) 

and then act according to the following: 

1. If the begin pay week is set to “transaction” then the system will start the 7 day 

count from X. 

2. If the begin pay week is set to a day of the week and X is also on the same day of 

the week, then the system will also start the 7 day count from X. 

3. If the begin pay week field is set to a day of the week and X is NOT on the same 

day of the week then the system will search backwards from X until it finds the 

first day which matches the day in the begin pay week field. It will then start the 

7 day count from that date. 

When determining number of hours to include in a given week overtime calculation they 

system will use the start date of a multi-day transaction and assign the hours to that 

date. 

For existing weekly rules for setup and maintenance records, the system will set the 

Begin Pay Week DDL to “transaction”. 

For example, if the company policy states anything over a 40 hour workweek is 

considered overtime. The system considers a week to be a 7 day period. The 7 day period 

begins on the date of the employee’s first transaction in the build or as dictated by the 

Begin Pay Week option. NOTE: Employees may have different start dates for their 7 day 

weeks if Transaction is selected for the Begin Pay Week option. 

 Period rules will apply rules to all transactions that happen within the payroll build. 

For example, if the company policy states anything over 80 hours is considered overtime. This is 

generally used for calculating overtime for a whole pay period, such as bi-weekly. If the pay period 

is monthly or semimonthly, then the rules should be set up to reflect the number of hours in the 

pay period. Typical examples (for a normal full time work year of 2080 hours) would be bi-weekly 

80, semimonthly 86.67 and monthly 173.33. 

Rule Detail Scrolling window 

This window is used to define the tiers/thresholds used when indicating how many hours are considered 

overtime.  

 Hours From and Hours To – These are used to define the range of hours. 

In the illustration below: 

Line 1 - Hours From 7.50 to Hours To 8.00 states that anything over 7.50 hours in a day but 

less than 8.00 hours would have an overtime hours payroll transaction created.   

If a payroll transaction is entered for 7.50 hours, the system will not create an overtime 

transaction, as the transaction has not exceeded the Hours From range.  



22 

Line 2 - Hours From 8.00 to Hours To 999,999.99 states that anything over 8.00 hours in a 

day would have an overtime hours payroll transaction created. 

When both ranges are specified and a user has worked 10.00 hours in a day. Two overtime 

payroll transactions will be created. One overtime payroll transaction is created for the 0.50 

hours, which is between the first range of 7.50 and 8.00 hours. A second overtime payroll 

transaction is created for 2.00 hours, which is the remaining balance over 8 hours based from 

the second range of 8.00 and 999,999.99 hours. 

NOTE:  It is best practice to use 999,999.99 as the end of your highest range defined for a 

rule.  

The system calculates differently if the user sets the range: 

 Hours From 7.50 to Hours To 8.00 

 Hours From 8.01 to Hours To 999,999.99 

It is recommended if the Hours To for the first range is 8.00 the user begin the second range 

Hours From to 8.00 also, as illustrated below. 

 

 Use Code – Tells the system which code to use when creating the overtime transactions for the 

ranges specified earlier. 

For example, the code used to pay for hours between 7.5 and hours in a day may be different than 

the code used to pay for hours that are over 8 per day. Each range can have a different code.  

 Description – Defaults from the Pay Code Setup window. It does not impact the calculation.  

 Pay Codes – When calculating overtime hours the system needs to know which pay codes to 

include when counting and adding up hours. The user needs to specify which codes should be 

included and does this by inserting codes from the Available window to the Include window. Only 

pay codes which are of type hourly (or are of types Sick, Vacation or Holiday based on type hourly) 

are included in the Available window. 

If the user receives an error message “Only one default rule for this type may exist. Unmark previous default 

rule?”; more detailed information and solution is provided in the Overtime Hours Rules Messages section. 
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Employee Overtime Rules Maintenance 

Window 
Cards > Payroll > Overtime Rules 

Cards > Payroll > Employee > GoTo > Payroll > Overtime Rules 

The Employee Overtime Rules Maintenance window is used to adjust overtime rules to suit an individual 

employee’s need, which will dictate the way overtime transactions are created in payroll. The window 

functions similarly to the Overtime Rules Setup window with only the following differences highlighted. 

 

Employee ID – If the user accessed the Employee Overtime Rules Maintenance window from the GoTo 

menu in Employee Maintenance then this field will display the employee ID of the employee which was 

selected at the time it was accessed. Otherwise this field is empty and you must select an employee ID by 

typing the ID or use the lookup button to select an ID. 

Employee Name – Displays the name of the employee whose employee ID is selected in the Employee ID 

field.  

Rule Code – Select a rule code by typing the code or use the lookup button to select a rule code. 
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Inactive – Mark this box will prevent the rule from being used by the system when calculating overtime for 

this employee. If this box is checked AND the Rule code has been deactivated in Overtime Rules Setup as 

well, then you will be unable to reactivate the rule from this window. You will need to reactivate it in 

Overtime Rules Setup.  

Include History TRX – Display from the Overtime Rules Setup window. 

Leave Originating TRX –Display from the Overtime Rules Setup window. 

Remove After Blended Rate Calc -   Displays from the Overtime Rules Setup window. 

7th Consecutive Day Overtime -   Displays from the Overtime Rules Setup window. 

Rule Description – Displays the description from the Overtime Rules Setup window. 

Rule Type – This field is read only in this window. 

Rule Detail Scrolling window – This window is used to define the tiers/thresholds used when indicating 

how many hours are considered overtime.  

Use Code – Although all codes of type Overtime and Double-Time are available to the user in the Use Code 

lookup, the use code specified must already be assigned to the employee as a pay code. 

Sometimes a rule code record is rolled down to Employee Overtime Rules Maintenance from setup and 

contains a use code which this employee does not even have available to him. 

For this reason, the system checks to make sure that the use code selected is one that the employee is 

eligible to use. It does this on the exit of the row in the scrolling window and again upon saving the record 

in general.  

Nonetheless if a Use Code is ever specified which the employee does not have assigned, the Overtime 

Hours Rules process will ignore that particular line in the calculation process. 

Pay Codes – At the employee overtime rules maintenance level the include codes will be checked by the 

system to make sure no duplicates are included in other rule codes of the same rule type. 

If the user receives an error message “You cannot activate a rule code for an employee when the rule code is 

inactive in setup.”; more detailed information and solution is provided in the Overtime Hours Rules Messages 

section. 
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Rules Code Mass Assign Window 
Microsoft Dynamics GP > Tools > Utilities > Payroll > Rule Code Mass Assign 

The Rule Code Mass Assign window allows the user to assign Overtime Rule Codes to multiple employees at 

once. 

 

The first step is to select a Rule Code by typing the rule code or use the lookup field, which will be assigned to 

employees. The next step is to designate which employees in the scrolling window are to be assigned the rule 

code. 

 Rule Code – When a rule code is selected, the rule type will then display for information purposes. 

 Filters – When values are specified for Department, Position and Employee Class the system will 

display only the employees that meet those criteria in the scrolling window.  

 Mass Assign Scrolling window – Allows the user to mark which employees should be assigned to 

selected rule code. To designate an employee simply check the include box in the scrolling window. 

The user can use the Mark All and Unmark All buttons. 

 Update Button – This button executes the mass assignment process. 

When mass assigning rule codes to employees it is important to keep in mind that a rule code may contain 

information that is not appropriate for the employee. 
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For example: 

1. A rule code may contain a use code that the employee does 

not yet have. If this is the case the system will still assign the 

rule code to the employee. Any use codes that are invalid for 

that employee will not be assigned to the employee. 

2. A rule code may also contain included pay codes that conflict 

with included pay codes that the employee has as part of an 

already existing rule code. If this is the case, the system will 

still assign the rule code to the employee but it will not assign 

the included codes that conflict with the previous rule code.  

After mass assigning a rule 

code it is Important to 

check maintenance 

records to make sure the 

included pay codes and use 

codes are correct. 
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Overtime Hours Build Report 
When a payroll build is completed the report will indicate if transactions were ignored. The system will ignore 

a transaction that would normally process if for some reason the pay code was altered and no longer was of 

type hourly (of type Sick, Vacation or Holiday based on type hourly). 
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Scenarios 

Example of Overtime Hours Rules with a Rule Priority Setup = Daily then Weekly then Period 

In this example, we have assigned a daily, weekly and period rule to employee Pilar Ackerman. Pilar is an 

hourly employee paid biweekly and her pay codes in a standard workweek are: HOUR, HOUR2, HOUR3 and 

VACN. 

The calculation priority for this example will process daily, weekly and then period rules. The tables below 

explain the automated process that creates the overtime transactions and adjusts the hourly transaction. The 

results of the automated calculation will appear on the Build report (see below). 

Overtime Hours Rules Setup Window 

 Calculation Priority = Daily, Weekly then Period 
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Bi-Weekly Payroll Transactions 

Week 1 Payroll Transactions 

Day of Week Date Pay Code Department Position Hours 

Sunday 03/26/2017 
HOUR ACCT ADA 7.50 

HOUR2 ADMN ADA 3.00 

Monday 03/27/2017 HOUR ACCT ADA 8.00 

Tuesday 03/28/2017 HOUR ACCT ADA 7.50 

Wednesday 03/29/2017 VACN ACCT ADA 7.50 

Thursday 03/30/2017 HOUR ACCT ADA 14.00 

Friday 03/31/2017 HOUR3 ACCT ADA 6.00 

Saturday 04/01/2017 
HOUR ACCT ADA 2.00 

HOUR2 ADMN ADA 2.00 

Week Total 57.50 
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Week 2 Payroll Transactions 

Day of Week Date Pay Code Department Position Hours 

Sunday 04/02/2017 
HOUR ACCT ADA 7.50 

HOUR2 ADMN ADA 3.00 

Monday 04/03/2017 HOUR ACCT ADA 8.00 

Tuesday 04/04/2017 HOUR ACCT ADA 7.50 

Wednesday 04/05/2017 VACN ACCT ADA 7.50 

Thursday 04/06/2017 HOUR ACCT ADA 14.00 

Friday 04/07/2017 HOUR3 ACCT ADA 6.00 

Saturday 04/08/2017 
HOUR ACCT ADA 2.00 

HOUR2 ADMN ADA 2.00 

Week Total 57.50 
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Daily Rule (Day01): 

As defined in the Overtime Rules Setup window: 

 Hours From 8.00 to Hours To 10.00 will be calculated using the OVER pay code rate. 

 Hours From 10.00 to Hours To 999,999.99 will be calculated using the DBL pay code rate. 

 

DAILY: The system first summarizes the daily transactions then applies the daily rule for the 

transactions, with the results in the following table. Each transaction in a day might be slightly 

different based on the department, position, SUTA State and Worker’s Comp. 
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Week 1 – Daily Rule Calculation Results 

Day of Week Date Pay Code Department Position Hours 

Sunday 3/26/2017 

HOUR ACCT ADA 7.50 

HOUR2 ADMN ADA 0.50 

OVER ADMN ADA 2.00 

DBL ADMN ADA 0.50 

Monday 3/27/2017 HOUR ACCT ADA 8.00 

Tuesday 3/28/2017 HOUR ACCT ADA 7.50 

Wednesday 3/29/2017 VACN ACCT ADA 7.50 

Thursday 3/30/2017 

HOUR ACCT ADA 8.00 

OVER ACCT ADA 2.00 

DBL ACCT ADA 4.00 

Friday 3/31/2017 HOUR3 ACCT ADA 6.00 

Saturday 4/1/2017 
HOUR ACCT ADA 2.00 

HOUR2 ADMN ADA 2.00 
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Week 2 – Daily Rule Calculation Results 

Day of Week Date Pay Code Department Position Hours 

Sunday 04/02/2017 

HOUR ACCT ADA 7.50 

HOUR2 ADMN ADA 0.50 

OVER ADMN ADA 2.00 

DBL ADMN ADA 0.50 

Monday 04/03/2017 HOUR ACCT ADA 8.00 

Tuesday 04/04/2017 HOUR ACCT ADA 7.50 

Wednesday 04/05/2017 VACN ACCT ADA 7.50 

Thursday 04/06/2017 

HOUR ACCT ADA 8.00 

OVER ACCT ADA 2.00 

DBL ACCT ADA 4.00 

Friday 04/07/2017 HOUR3 ACCT ADA 6.00 

Saturday 04/08/2017 
HOUR ACCT ADA 2.00 

HOUR2 ADMN ADA 2.00 

For information such as SUTA State and Worker’s Comp, the system uses the details from the 

Employee Pay Code Maintenance window to determine the appropriate SUTA State and Worker’s 

Comp.  
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Weekly Rule (Week1): 

As defined in the Overtime Rules Setup window: 

 Hours From 40 to Hours To 999,999.99 will be calculated using the OVER pay code rate. 

 

  



35 

Week 1 – Results from Daily Rule to be used for Weekly Rule calculation 

Day of Week Date Pay Code Department Position Hours 

Sunday 3/26/2017 

HOUR ACCT ADA 7.50 

HOUR2 ADMN ADA 0.50 

OVER ADMN ADA 2.00 

DBL ADMN ADA 0.50 

Monday 3/27/2017 HOUR ACCT ADA 8.00 

Tuesday 3/28/2017 HOUR ACCT ADA 7.50 

Wednesday 3/29/2017 VACN ACCT ADA 7.50 

Thursday 3/30/2017 

HOUR ACCT ADA 8.00 

OVER ACCT ADA 2.00 

DBL ACCT ADA 4.00 

Friday 3/31/2017 HOUR3 ACCT ADA 6.00 

Saturday 4/1/2017 
HOUR ACCT ADA 2.00 

HOUR2 ADMN ADA 2.00 
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Week 2 – Results from Daily Rule to be used for Weekly Rule calculation 

Day of Week Date Pay Code Department Position Hours 

Sunday 04/02/2017 

HOUR ACCT ADA 7.50 

HOUR2 ADMN ADA 0.50 

OVER ADMN ADA 2.00 

DBL ADMN ADA 0.50 

Monday 04/03/2017 HOUR ACCT ADA 8.00 

Tuesday 04/04/2017 HOUR ACCT ADA 7.50 

Wednesday 04/05/2017 VACN ACCT ADA 7.50 

Thursday 04/06/2017 

HOUR ACCT ADA 8.00 

OVER ACCT ADA 2.00 

DBL ACCT ADA 4.00 

Friday 04/07/2017 HOUR3 ACCT ADA 6.00 

Saturday 04/08/2017 
HOUR ACCT ADA 2.00 

HOUR2 ADMN ADA 2.00 

WEEKLY: Based on the Priority Rule setup the system will calculate daily, weekly then period. The 

system applied the daily rule and now the system will determine if the weekly rule needs to be 

calculated. The weekly rule states that 40 hours and over should use the OVER pay code rate. 

After applying the daily rule, the non-overtime transactions now add up to 49 hours. This leaves nine 

hours of overtime which was not accounted for in the daily rules. So we can expect the system to 

generate nine hours of overtime and reduced the non-overtime hours accordingly. 

The following illustrates how the system handles the transactions. Note that overtime for the week is 

credited at the point during the week which the employee exceeds the threshold; in this case Friday 

after the first hour of the day. 
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Week 1 – Weekly Rule Calculation Results 

Day of Week Date Pay Code Department Position Hours 

Sunday 3/26/2017 

HOUR ACCT ADA 7.50 

HOUR2 ADMN ADA 0.50 

OVER ADMN ADA 2.00 

DBL ADMN ADA 0.50 

Monday 3/27/2017 HOUR ACCT ADA 8.00 

Tuesday 3/28/2017 HOUR ACCT ADA 7.50 

Wednesday 3/29/2017 VACN ACCT ADA 7.50 

Thursday 3/30/2017 

HOUR ACCT ADA 8.00 

OVER ACCT ADA 2.00 

DBL ACCT ADA 4.00 

Friday 3/31/2017 
HOUR3 ACCT ADA 1.00 

OVER ACCT ADA 5.00 

Saturday 4/1/2017 

HOUR ACCT ADA 0.00 

HOUR2 ADMN ADA 0.00 

OVER ACCT ADA 2.00 

OVER ADMN ADA 2.0 
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Week 2 – Weekly Rule Calculation Results 

Day of Week Date Pay Code Department Position Hours 

Sunday 04/02/2017 

HOUR ACCT ADA 7.50 

HOUR2 ADMN ADA 0.50 

OVER ADMN ADA 2.00 

DBL ADMN ADA 0.50 

Monday 04/03/2017 HOUR ACCT ADA 8.00 

Tuesday 04/04/2017 HOUR ACCT ADA 7.50 

Wednesday 04/05/2017 VACN ACCT ADA 7.50 

Thursday 04/06/2017 

HOUR ACCT ADA 8.00 

OVER ACCT ADA 2.00 

DBL ACCT ADA 4.00 

Friday 3/31/2017 
HOUR3 ACCT ADA 1.00 

OVER ACCT ADA 5.00 

Saturday 04/08/2017 

HOUR ACCT ADA 0.00 

HOUR2 ADMN ADA 0.00 

OVER ACCT ADA 2.00 

OVER ADMN ADA 2.00 

  



39 

Period (PER1): 

As defined in the Overtime Rules Setup window: 

 Hours From 90 to Hours TO 999,999.99 will be calculated using the DBL pay code rate. 
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Week 1 – Results from Daily, Weekly Rules to be used for Period Rule calculation 

Day of Week Date Pay Code Department Position Hours 

Sunday 3/26/2017 

HOUR ACCT ADA 7.50 

HOUR2 ADMN ADA 0.50 

OVER ADMN ADA 2.00 

DBL ADMN ADA 0.50 

Monday 3/27/2017 HOUR ACCT ADA 8.00 

Tuesday 3/28/2017 HOUR ACCT ADA 7.50 

Wednesday 3/29/2017 VACN ACCT ADA 7.50 

Thursday 3/30/2017 

HOUR ACCT ADA 8.00 

OVER ACCT ADA 2.00 

DBL ACCT ADA 4.00 

Friday 3/31/2017 
HOUR3 ACCT ADA 1.00 

OVER ACCT ADA 5.00 

Saturday 4/1/2017 

HOUR ACCT ADA 0.00 

HOUR2 ADMN ADA 0.00 

OVER ACCT ADA 2.00 

OVER ADMN ADA 2.0 
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Week 2 – Results from Daily, Weekly Rules 
to be used for Period Rule calculation 

Day of Week Date Pay Code Department Position Hours 

Sunday 04/02/2017 

HOUR ACCT ADA 7.50 

HOUR2 ADMN ADA 0.50 

OVER ADMN ADA 2.00 

DBL ADMN ADA 0.50 

Monday 04/03/2017 HOUR ACCT ADA 8.00 

Tuesday 04/04/2017 HOUR ACCT ADA 7.50 

Wednesday 04/05/2017 VACN ACCT ADA 7.50 

Thursday 04/06/2017 

HOUR ACCT ADA 8.00 

OVER ACCT ADA 2.00 

DBL ACCT ADA 4.00 

Friday 3/31/2017 
HOUR3 ACCT ADA 1.00 

OVER ACCT ADA 5.00 

Saturday 04/08/2017 

HOUR ACCT ADA 0.00 

HOUR2 ADMN ADA 0.00 

OVER ACCT ADA 2.00 

OVER ADMN ADA 2.00 

PERIOD: Based on the Priority Rule setup the system will calculate daily, weekly then period. The 

system applied the daily and weekly rules and now the system will determine if the period rule needs 

to be calculated. The period rule states that 90 hours and over should use the DBL pay code rate. 

After applying the daily and weekly rules, the remaining non-overtime transactions now add up to 40 

hours for the week that would be 80 hours for the period since the build contained two weeks’ worth 

of transactions. No thresholds are exceeded so there are no modifications for the period rule.  
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Build Report 

This Build Report reflects the results after the overtime rules have been applied. The OVER and DBL 

transactions have been added and the hourly transactions were reduced.
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Hints and Essentials  

Important Notes: 

1. When using both Microsoft Payroll Extensions Overtime Rate Manager and Overtime Hours Rules 

functionality, the OHR6489.dic file must be referenced prior to the HRMSS.dic file in the users 

Dynamics.set file. 

2. When using both Comprehensive Leave Manager and Overtime Hours Rules, the OHR6489.dic file 

must be referenced prior to the ELM.dic file in the users Dynamics.set file. 

3. When using both Negative Payroll Transactions and Overtime Hours Rules, Negative Payroll 

Transactions must be entered into the system on the beginning date of the transactions.    

4. If an employee is assigned an overtime rule that contains a use code for overtime transaction which is 

inactive or not assigned to the employee; the system will not process an overtime transaction for the 

tier that contains that use code. 

5. If the user inactivates a rule, which is designated as a default rule, then that rule will not be used in 

the overtime rules calculation process. This will impact all users who use only the default rule.  

6. When an overtime rule contains multiple tiers and the system processes overtime for multiple tiers 

then the overtime transaction that is created will inherit the demographic information from the 

originating transaction and Employee Pay Code Maintenance. 

7. Inactive rule codes assigned to employees will prevent other rule codes from being assigned that have 

the same included codes. Therefore it is important not to accumulate inactive codes for an employee 

as they will eventually cause conflicts with new rules being assigned. 
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FAQ’s 

Can you have multiple overtime rules assigned to an employee?  For example, overtime is 
anything over 8 hours in a day or 40 hours in a week. 

Yes, you may assign multiple overtime rules to an employee.  

If you want to have one of each rule type apply to all employees do you have to assign each 
employee the Overtime Rules? 

Overtime Hours Rules will allow the user to set a default rule for each rule type. The default rules will be 

applied to all employees who do not have an overtime rule assigned. 

Is Overtime Hours Rules supported for bi-monthly or monthly payrolls? 

No, Overtime Hours Rules supports only weekly or bi-weekly payrolls. 
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Activation Manager Messages 

Activation Failed: Trial invalid or trial period expired 

Situation: The trial period has expired for the product.  

Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.  

Activation Failed: Site name does not match this installation 

Situation:  The site name does not match the token which was issued. 

Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error 

message displayed so the token can be updated with the correct site name. 

Activation Failed: Product Name does not match this installation 

Situation: The product name does not match the token which was issued for a product. 

Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error 

message displayed so the token can be updated with the correct site name. 

Trial period for Overtime Hours Rules has expired 

Situation: The trial period has expired for the product. 

Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product. 

Employees Allowed has been exceeded 

Situation: The current employee count has exceeded the employees allowed. 

Solution: Contact sales@integrity-data.com to upgrade to the next tier. 

Activation Failed: Unable to contact web service. Activate manually or revert to previous 
product dictionary 

Situation: The system could not make a connection to the web service. 

Solution: Contact support@integrity-data.com for assistance. 

Activation Failed: Product has been deactivated 

Situation: The product has been deactivated. 

Solution: Contact support@integrity-data.com for assistance. 

Upgrade Failed: Enhancement Plan period expired.  Renew Enhancement Plan or revert to 
previous product version. 

Situation: User attempted to upgrade a product when their enhancement plan was expired. 

Solution: Contact sales@integrity-data.com to renew the enhancement plan. 

Overtime Hours Rules: Activation Failed 

Situation: Communication breakdown between the user machine and Integrity Data. 

Solution: Contact support@integrity-data.com for assistance. 

mailto:sales@integrity-data.com
mailto:support@integrity-data.com
mailto:support@integrity-data.com
mailto:sales@integrity-data.com
mailto:sales@integrity-data.com
mailto:support@integrity-data.com
mailto:support@integrity-data.com
mailto:sales@integrity-data.com
mailto:support@integrity-data.com
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Overtime Hours Rules Messages  

You must inactivate the Automatic Overtime feature in GP before activating Overtime Hours 
Rules. OK 

 

 

Situation: User attempted to activate the Overtime Hours Rules feature while the Automatic Overtime feature 

was enabled in GP. 

Solution: Inactivate Automatic Overtime feature. (Microsoft Dynamics GP > Tools > Setup > Payroll > Payroll) 

You must inactivate Overtime Hours Rules before activating Automatic Overtime. OK  

 

Situation: The user attempted to check the Automatic Overtime checkbox while Overtime Hours Rules 

functionality was activated. 

Solution: Open the Overtime Rules Setup window and unmark Activate Overtime Hours Rules. 

Only one default rule for this type may exist. Unmark previous default rule? Delete Cancel 

 

Situation: User attempted to mark a rule record as default when another rule record was selected as default 

for same record type. 



47 

Solution: Delete this current rule and unmark the previous default rule. 

Pay codes were not assigned since already in use by another rule code of the same rule type. 
OK 

 

Situation: User attempted to save a record that contained pay codes already in use by another rule code 

belonging to the same rule type. 

Solution: Remove pay codes from the other rule type. 

You cannot activate a rule code for an employee when the rule code is inactive in setup. OK 

 

Situation: User attempted to enter an inactive rule code. 

Solution: Make the rule code active or select an active rule code. 
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Deactivate Product 
There are three ways to deactivate the Overtime Hours Rules; disable, inactive or uninstall. 

Disable 

To disable Overtime Hours Rules without having to exit Microsoft Dynamics GP, open the Customization Status 

window. To open this window, select the Microsoft Dynamics GP menu, point to Tools, select Customize and 

then click Customization Status. Select the product from the list and click Disable. The product can be enabled 

by closing and reopening Microsoft Dynamics GP. 

Inactivate 

Option 1: Overtime Hours Rules can be inactivated by company, open the Activation Manager window and 

unmark the company checkbox. 

Option 2: Overtime Hours Rules can be inactivated by opening the Overtime Hours Rules Setup window and 

unmarking the Activate Overtime Hours rules checkbox. To open this window, select the Microsoft Dynamics 

GP menu, select Tools, select Setup, select Payroll and then select Overtime Hours Rules Setup. 

Uninstall 

If Overtime Hours Rules needs to be uninstalled complete these steps on the server and the client where 

Overtime Hours Rules has been installed. 

1. Remove the OHR6489.DIC file from the Runtime Directory 

Default location is C:\Program Files\Microsoft Dynamics\GP2015 or C:\Program Files\Microsoft 

Dynamics\GP2016 

2. Make a copy of the Dynamics.set file 

3. Open the Dynamics.set file 

a. Decrease the top number by one: 

For example, if the top number is 21 change it to 20 

b. Remove the following lines from the Dynamics.set file: 

6489 

Overtime Hours Rules 

:C:Program Files/Microsoft Dynamics/GP/OHR6489.DIC 

:C:Program Files/Microsoft Dynamics/GP/Data/OHR6489F.DIC 

:C:Program Files/Microsoft Dynamics/GP/Data/OHR6489R.DIC 

4. Save the Dynamics.set file 

5. Launch Microsoft Dynamics GP and login as the ‘system administrator’  
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Uninstall Activation Manager 
Activation Manager will manage activation for all Integrity Data Products.  If you are uninstalling all Integrity 

Data products, you need to remove the Activation components. 

IMPORTANT: If you uninstall one product but have other Integrity Data products do not uninstall the 

Activation Manager components. 

1. Make a copy of the Dynamics.set file  

2. Open the Dynamics.set file 

a. Decrease the top number by one: 

For example, if the top number is 21 change it to 20 

b. Remove the following lines from the Dynamics.set file: 

 

6537 

Integrity Data Activation 

:C:Program Files (x86)/Microsoft Dynamics/GP2013/IDA6537.DIC 

:C:Program Files (x86)/Microsoft Dynamics/GP2013/Data/IDA6537F.DIC 

:C:Program Files (x86)/Microsoft Dynamics/GP2013/Data/IDA6537R.DIC 

1. Save the Dynamics.set file 

Make a copy of the Dynamics.exe.config file.   

3. Edit Dynamics.exe.config and find the line(s) beginning with: 
 

<addin name=”IDKeyManagerAddin” 

 

4. Remove the lines from both the <Dynamics> and <DynamicsGPWeb> sections. 
 

5. Save the Dynamics.exe.config file 
 

6. Launch Microsoft Dynamics GP and login as the ‘system administrator’ 
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Contact Information 
Get quick answers to your questions 

Browse our convenient Knowledge Base for up-to-date answers to the most common questions. For additional 

questions, please contact your authorized Value Added Reseller (VAR) for support on this product (if you have 

one) or contact Integrity Data by emailing support@integrity-data.com or calling 888.786.6162. 

If you have registered your product, Technical Customer Service is available for any customers with a current 

Enhancement Plan or subscription. Please have your Company or Site Name available. Your first line of support 

should always be your VAR (if you have one). 

Join our User Groups 

We have an HR and payroll focused one and an ACA one – email lbelley@integrity-data.com to join! 

Rate us and our products 

Are you pleased with your experience with us and our products? Provide a quote and get a gift card! Fill out the 

form on our contact page and leave your quote in the comment section. 

Suggest new features or improvements 

User input into improving this product and constructive feedback are appreciated. Please e-mail Tom, our 

Product Manager, at tfranz@integrity-data.com. As always, technical ideas and user input are highly 

encouraged. At Integrity Data, we want to hear your input, so drop us a line! 

Browse our solutions 

The Integrity Data website is a great place to get additional information on products and services. The 

following information is available on our website: 

 Integrity Data’s HR & Payroll software pages include Demos, Features and Benefits, and ROI 

Calculators 

 Visit our Services page to learn more about our additional customization services 

If you would like to discuss your needs with a Sales Account Executive, please call 888.786.6162 or e-mail 

sales@integrity-data.com. 

http://www.integrity-data.com/knowledge-base
mailto:support@integrity-data.com
mailto:lbelley@integrity-data.com
http://www.integrity-data.com/contact
mailto:tfranz@integrity-data.com
http://www.integrity-data.com/software
http://www.integrity-data.com/services
mailto:sales@integrity-data.com

